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Section 1

General Information

Hydras 3 LT is software used to connect Hydrolab sondes to a PC. It automatically scans
for connected sondes and recognizes any log files held in memory. Up to 32 sondes can
be connected at once, and all log files can be downloaded simultaneously.

When operating the sonde, Hydras 3 LT provides seven function tabs to help view
real-time data, or to set up a sonde for operation:

The System tab allows the user to setup basic sonde identification information.
Also, passwords can be established to allow up to four different access levels,
which can help to protect the data.

The Online Monitoring tab allows viewing real-time data as either a time series
graph, or as a vertical profile graph. Up to six parameters can be viewed at a time
on either graph. Data can also be downloaded into an Excel or text file.

The Log Files tab allows quick and easy setup of logging runs with a GUI
interface. Choose the start and stop time, the logging interval, as well as the
circulator and sensor warm-up time. Add or remove parameters and arrange them
in order. When the logging run is complete, download all the files at once.

The Parameter Setup tab allows the user to configure available parameters.

The Calibration tab sets the calibration parameters for an individual sensor.
Choose the sensor to calibrate and enter the calibration standards. The current
value and temperature readings are shown for temperature sensitive calibrations.

The Settings tab sets the communication settings between the Hydras 3 LT and
the sonde.

The Software tab uploads software to the sonde and updates and removes
software drivers.
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Section 2  Startup

1. Connect the Data Cable from the computer and to the sonde.

2. Start Hydras 3 LT. The software will automatically scan for sondes. All detected
sondes are displayed in the ‘Connected sondes’ list in the Main window displayed
below. If a sonde is not found, press RE-SCAN FOR SONDES. If a connection can not
be established, refer to Appendix A Troubleshooting on page 29.

ET=Tl=1F

File Help
Connected Sondes:
Puart | Sonde |
COr1 DataSonde 5/ 41026 [19200]
Re-Scan for Sondes
Operate Sonde
Terminal kMode
Log Files:
Part | Laqg File | Progress |
Dowrload Selected Files | [T Delete files in sonde after reading
Save files to; :%Program FileshHYDRASZLT SLogFilesh Edit |

| | 4
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2.1 Downloading Data

After a log file is created in the Log Files tab, the files can be downloaded by checking the
appropriate Log File box and clicking DOWNLOAD SELECTED FILES. Multiple files can be
downloaded at once. The downloaded log files are stored in the location indicated at the
bottom of the screen (typically “C:\Program Files\HYDRAS3LT\LogFiles”). The location
can be changed by clicking EDIT and specifying a new directory.

E=TIM=ES

File Help

Connected Sondes:

Fart | Sonde |
COR1 DataSonde 5 4 41026 [15200]
Re-Scan for Sondes
Operate Sonde
T erminal Mode
Laqg Files:
Port | Log File | Progress |

[x] COM1 Log File

Download Selected Files | [T Delete files in sonde after reading

Save files ta: C:%Program FileshHYDRASSLT \LogFiles®, Edit |

| | 4

2.2 Operating a Sonde

Note: To enter a higher level security mode, click on the Level button from the System Tab and enter
the password.

1. From the Main Hydras 3 LT menu, highlight the appropriate sonde and press
OPERATE SONDE. The sonde window will appear. The window defaults to
Security Level 2.

2. The sonde window contains 7 function tabs; System, Online Monitoring, Log Files,
Parameter Setup, Calibration, Settings, and Software.
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2.2.1 System Tab

The System Tab sets up general information and configures the system components.

ol -0l x|

 System I Online konitaring I Log Files I Parameter Setup I Calibration I Settings I Software I

[ntument 10 Ir‘u’a Set ID! : )

—Sonde information
b anufacturer; IH_I,u:Irn:-IaI:n
b odel; IDataS ande 5
C Sernal nurber; |41 026
2)
Software version: |5.33
b adbuz version: I'I a2
Date of Manufacture: |1 2242005
—Clock
Date # Time: |1 2M2/2005 |‘I 1:46:41 Ak
@) Set clock ta PC time
Set clock manually [12/12/2005 ~loooooo =

Circulatar

@ Start Stap
Audio

@ On [ fF

Security Level

Level 0 Lewvel 1 | Level 2 | Paszwardz |

| | [11:46:41 &M y

# | Function Description

Instrument 1D Enter a description of the sonde. This will be used as an output on the data file.

2 | Sonde Information | Displays static information about the sonde.

Sets the sonde date and time to match your PC clock or manually set the date and time (this is

3 | Clock useful when monitoring in different time zones).
Circulator Select whether to start or stop the circulator.
Audio Turns on/off the beeping sound the sonde makes when taking measurements.

Click on LEVEL 0, LEVEL 1, LEVEL 2, or LEVEL 3 and enter the password to view that security mode.
6 | Security Level While in Level 3, click on PASSWORDS to set the passwords for Level 1, Level 2, and Level 3. The
default Level 3 password from the factory is “Hydrolab”.
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2.2.2 Online Monitoring Tab

The Online Monitoring Tab has three modes for capturing data; Manual, Time Series, and
Vertical Profile (sections 2.2.2.1, 2.2.2.2, and 2.2.2.3). Criteria checks can be set before
capturing the data (section 2.2.2.4) and then the results can be graphed (section 2.2.2.5).

B\ YDROLAB - COM 1 -65| -1o] x|

Spstern  Online Monitaring | Log Files I Parameter Setup I Calibration I S ettings I Software I

M onitaring Mode: ITime Semies j Start I Stop I
Moanitoring [nteryal: I 00:00:05 j @

[ Wsze Stability Check [Canfiguration I Samples per Measurement: |1 =i
Farameters:

|:| rH Thits -—=

[Jopp wlf _— Firzt 5 ample;

L] spCond ns/cn - Last Sample:

O SpCond na s cm -

[ pes T p— _— # Samples: 0

[l ga1 rpt - Internal B atteny:

o s 3/ T External Battery:

[ bepthin meters L stermal Battery: .

[l pepth wx wolts -— + | Circulabor—————
| Depth_Wy nvolts -——— @ | |
[ Turbidity Volts — ¥ | Start Stop

[] Turbidicy NTU —

[] Turkidicy Dew — @ Ny Graph

[ Loos Sat _—

[]Lro w1 -

[]Loo_EP nnHy L e Depth Graph

[ rressure p=sig -—=

[ chlarephyll Sl -—= I j
[ chlorophyll Volts -—-

[l Internal-Eattery Volts - [Hew Table

O External-Battery Tolts -—=

[T cireulatar Status -—= Expart EXEEL

Ewpart Testfile
Transfer To Databaze
11:45:35 &M o
# | Function Description

The monitoring mode must be set before starting Online Monitoring. Select Time Series for logging
1 | Monitoring Mode values at regular time intervals. Select Vertical Profile for logging values at user-defined depth
levels. Or select Manually for User-defined logging.

Select the time interval or depth level between samples as well as the stability check for Vertical

2 | Monitoring Interval Profile and Manual settings (see section 2.2.2.4).

3 | Parameters Check the parameters to be monitored.

4 | Arrow buttons Select a parameter and use the UP and DOWN arrow buttons to move the parameter in the list.
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New Graph: Opens a graphic window with the selected parameters (max. 6) plotted as a time
series. See Real-time Graph Functions on page 15 for more information on changing graph
properties.

New Depth Graph: Opens a graphic window with the selected parameters (max. 6) displayed at
the corresponding depth.

Data Buttonsl

(Monitoring must New Table: Displays the selected monitored data in a tabular view (real-time).

5 begin before Export Excel: Microsoft Excel must be installed on the computer for this function to work. The
the data button monitored data is transferred to an Excel application running in the background. If Excel is not
functions can running, it is automatically started and a new worksheet is created. After the data is exported, the
be used) Excel file is not updated with new real-time data. Hydras 3 LT continues to log such data for

graphing and storage purposes.

Export Textfile: Writes the monitored data to a text file. After the data is exported, the file is not
updated with new real-time data.

Transfer to Database: Not available with Hydras 3 LT.

1 The data buttons become available when at least one parameter in the list is selected.

2.2.2.1 Time Series

A time-based logging can be set by selecting Time Series as the Monitoring Mode. The
user must select the time interval and parameters. Click START to begin monitoring data
(see section 2.2.2 for a screen shot).

11
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2.2.2.2 Vertical Profile

A vertical profile can be set by selecting Vertical Profile as the Monitoring Mode. The user
must select the depth increment for the vertical profile, the units of measure for the profile,
and whether the profile is ascending (up arrow) or descending (down arrow). The user
should also indicate whether or not a stability check is to be used and how many samples
per measurement point are preferred.

ERHYDROLAB - COM 1 KL= =] E3

Sypztemn  Onling Manitoring I Lag Filesl F'arameterSetupI Ealil:uratiu:unl Settingsl Su:uftwarel
Start | o2 i ) |

Manitaring Mode: Y ertical Profile

Depth increment far vertical prafile: I'I.UU IDep'IEIEI [meters] j il

v Use Stability Check Configuration | Samples per Meazurement: |1 j

Parameters:

Tenp °c 2z 44 .

- Unite . Current Depth:

[]omp wlf —r4a* Last Depth: 1200000 Abd

EpCornd ws S om o.1+* Mext Depth:

[ &pCond nEfcm 77 _

[ pes EO-cm 1a* # Samplez: ]

[lgal ppt I lcLy Internal Batterp:  9.2% [0 %]
D2 1 o.a*

E — g;t o o+ External Battery: 9.0 [0 %]

[Jro mepi 1 0.00% + Circulator—————

CEr mmHer 7e0%* | |

[T peploo meters Zd g7 * | Star Sizm

[ repthx wolts Z_500

[Joepthy wwolts 35_08 W B Eranh

[ Turkbidity Yolts 24995

[] Turbidity NTU s000%

[ Turbidity Bew ] 1zt Dzt Ciraph

[] chlorophyll pasl 23_ag*

[ chloraphyll Vaolts 4.9990 IDEF"' 00 [meters] j

| Internal-Battery Wolts Q_F

[]External-Eattery Volts 2.0 [{Eewiiiable

D Circulator Status 1

vt EsEEL

Ewmart I erttie

iranzfen o [atahase

B:44:39 AM .
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2.2.2.3 Manual Profile

A manual profile can be set by selecting Manually as the Monitoring Mode. The user
should also indicate whether or not a stability check is to be used and how many samples
per measurement point are preferred. The data is captured by either pressing the space
bar or by clicking on the capture button

ERHYDROLAB - COM 1 K] [s] E3

Systern  Online Monitaring |L|:|g Filesl Farameter Setupl Ealil:uratiu:unl Settingsl Snftwarel

Monitoring Mode: IM‘I Start | Stop |
h- [Eapfire I

W
[ Use Stability Check Configuration I Samples per Measurement: |1 j
Farameters:
Tenp "C 2237
[ orr wy _ZEF* First Samnple: 12:00:00 Ak
EpCond wid S om 0.1+ Last Sample:
[ sprond HE S om 106+
[pes El—cm g # Samples: 1]
E gal ppt 0. oa* Internal Batteny: 9.2 % [0 %]
DS 41 0.1* .
[ pos gat I External Battery: 9.1 % [0 %]
[Too mosl 0.oo* + Circulator
Cler g TeaT Stk | Sta |
[Joeplon meters 24857 * | P
[ peprh wolts Z_500
[ peprhy nwolts 35.05 e Granh
[ Turbidity Volts 2.4997
(] Turkidicy NTU 0004
[ et et Eraph
[ Turkbidiey Lew 1] H H
[l chlorophyll Basl 99_ag*
[l chlorephyll Volts 49930 IDEme [meters] j
O Internal-Battery Tolts 9.2
[] Exrernal-Eartery Tolts 9.1 [{Etw Tiakle
[Tcirculator Status 1

Ewnpart EsEEL

Evport Tiestfile

Iirareten o [atahase

4236 AM v

13



Startup

2.2.2.4 Stability Check

When monitoring in Depth Mode or Manually, the user can set up stability criteria which
must be met prior to Hydras 3 LT recording a measurement. The user needs to select a
given parameter such as SpCond, the maximum delta (+ this number from an average
value), the units of measurement, and the number of samples that must meet this stability
criteria. To select a parameter of interest, click on the parameter name in the Stability
Criteria window. The check box in front of the parameter name is used to indicate whether
that parameter will be used as part of the stability criteria check. When more than one
stability criteria is checked, all conditions must be met for data to be collected. Click on
CONFIGURATION in the Online Monitoring screen to enter the stability criteria screen.

[l stability Criteria

-8| - 10 x|

Click. an parameter name ta edit criteria for thiz parameter:

Check far parameter iz only activated, if checkboy iz checked.

Farameter | kax. Delta | | Irit | # Samples | -
O Intemal-E atterny 0 Wolts 0
[ Esternal-E attery 0 Walts 0
O Intemal-B attery a ELeft a
[ E sternal-E sttery 0 ELeft a
O Temp a ‘C a
O Iemo a ’F a
O Temp a K a
O Depthin 0 meters 0
O Depthin a feet i
O Bressure a g a
[ Depth Wy 0 rvolks a
O Cepth a wolts a
SpCond . NS A CI 3 —
[ 5oCond a p3/em a
O Res 0 kO-cm O
O:zal a pot a
O1os a a/l a
OcH a Urits a
O ore g m 0 hd
Farameter: ISDEDnd
b aw. Delta: ID'-I
L rik: I""'S"'I cmn j
# Samplez I3 i[l il
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2.2.2.5 Real-time Graph Functions

Up to six selected parameters can be displayed with different colors and an individual axis
range for every sensor. In the graphic options (F2), the user can select if every parameter
has its own vertical axis displayed or that only 2 vertical axis are used (one left, one right).

To change the scale on the y-axis, click on the minimum and maximum values on the
graph. A dialog box will appear, enter the minimum and maximum y-axis values. Press
Ctrl-A to autoscale the y-axis at any time while the data is plotted on the graph.

Right-click on the graph to display a context menu. See the table below for context
menu options.

m Online monitoring [_ O]
File
+iTemp [°C] TipCaond [mSiem)
“ipH [Unit=] " SpCond [pSiem)
4LORP [m] */00% [Sat]
Iete ] my ™ 1174 e at
S000- 1000 £5.00 4 ~1400 5D ~100.0
50.00 1 L 000
-12.00
4000 4.0 L &00
A00 4 40.00
2000 4 3.0 L GO0
20.00 Span B[ | =00
04 , ; Grid ] L 0.0
2000 20.00 Ovwerlay Statistics .00 20 | 4o
Table
L .00 - 0.0
5004 10000 Rl
1000 - L1.0 L 200
L 2.00
D-DD . I~ 1|:||:|
o~ -pood -5.00 . — — T e B = ooo o Loo L oo
16:15:45 16:16:00 16:16:15 16:16:30
114242002 4:15:40 P [5=] 114242002 4:16:40 AR
Circulatar: OFF
Function Description
Select the time span that is displayed until the current value (1 min, 5 min, 10 min, 30 min, 1 h, 3 h, 6
Span
h, 12 h, or 24 h).
Grid Turn the horizontal and vertical grid on or off.

Overlay Statistics

Select overlay statistics to show simple statistics on the graph such as max, min, and average.

Table

Select table to view the graph in a tabular form.

Ruler

Turn the two rulers on or off.
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2.2.3 Log Files Tab

Users frequently like to use the same Log File settings for multiple sondes or for
redeploying a sonde after retrieving a stored log file. The Log Files tab allows the user to
share and retrieve template Log File settings using a right-click while the cursor is in the
Log Files screen.

2.2.3.1 Creating a Log File

Note: A log file must be created and then enabled before data can be collected.

1.
2,

Click the CREATE button.

Enter the name for the new log file. The empty log file is now created.

Note: To delete a log file, select the log file in the Log File drop-down menu and click the DELETE
button.

3.

Enter the start and end time of the log, the logging interval, the sensor warm-up time
before logging, and how long before logging the circulator will be turned on, and if
audio signals will be used while logging.

Select the parameters in the ‘Parameter in sonde’ list and click the ADD button to
place them into the ‘Parameters in log file’ list. Change the order of the parameters
using the UP and DOWN arrow buttons.

Click SAVE SETTINGS to send the configuration to the sonde.

Click ENABLE to start collecting data. Click DISABLE to stop collecting data during
logging. A fully completed logging run will automatically disable at the end of the run.

Click DOWNLOAD to download and display the log file. Select Printable or
Spreadsheet format.

16
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2.2.3.2 Storing a Template File

Note: In order to create a stored template file, a sonde must be connected to Hydras 3 LT.

1. Open an existing log file by using the Log File pull-down menu or create a new log file
by following steps 1-4 in section 2.2.3.1.

2. While the cursor is in the Log Files screen, right-click to open the template selection
screen.

3. Select STORE TEMPLATE.

4. Choose a name for the template. It will be stored automatically in the template folder.
Reusing a template name will overwrite the old template.

5. Select SAVE.

6. The log file template is now saved and can be used to speed up the creation of future
log files.

EiHYDROLAB - COM 1 R =] B3
S_I,Isteml Orline Monitoring ~ Lag Files | Parameter Setupl Ealil:uratiu:unl Settingsl Su:-ftwarel
Log File: ILDg File j Sawe Settings |
Type: Time Triggered
Statusz Dizabled
Created: 11942004 00:00:00
Size [Butes/Scanz]: 040 497250 Bytes left
Start Logging: [117 92004 =]f032813 =
Stop Logging: [117 92004 =l[102813 =
Logging Interwal: IEI'I 0000 ﬁ
Senzar Warmup: I 00:02:00 ﬁ
Circulatar W armup: IEIEI:EIE:EIEI ﬁ v Audio
Farameters in Sonde: Farameters in Log File:
Temp ['C] - ORP [m\]
pH [Urits] 0 [ .
ORP [m\] DO% [Sat]
SpCond [mS fem] v |
SpCond [pS/om]
Res [kO-cm)
Sal [ppt]
TDS Ea’l
TR Load Template
DO [mgd) 2 2
BPF [mmHg]
Ciep100 [meters) j HIEmEE |
Create | Enable | [Mzable | Delete awhlzad | Irarishen [DE |
| | |9:34:50 AM v
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2.2.3.3 Recalling Template Files

Note: In order to use a template file, the sonde used to create the template and the sonde used
when retrieving the template should be configured in a compatible manner. That is, all parameters
used in the template file should be available in the sonde to which the template file is being applied.

1. Click the CREATE button to create a new log file or open an existing log file by using
the Log File pull-down menu.

2. Enter a name for the new log file, if necessary. An empty log file is created.

3. While the cursor is in the Log Files screen, right-click to open the template
selection screen.

4. Select Load Template.

5. The template will load onto the Log Files screen. It will be identical to the stored
template except the Start Logging start time will be the current PC time.

6. Verify that all items are prepared as needed, including the Start Logging and Stop
Logging times.

7. Click SAVE SETTINGS to send the configuration to the sonde.

8. Click ENABLE to start collecting data.

ERHYDROLAB - COM 1 K=l M[=] E3
Systeml Orline Monitoring  Log Files |F'arameter58tup| Calibrationl Settingsl Suftwarel
Lag File: |L|:|g File j Save Sethings |
Type: Time Triggered
Status: Dizabled
Created: 1143/2004 00: 0000
Size [Bytez/Scanz]: 040 497280 Bytes left
Start Logging: [11/ 92004 =|[om2sis =
Stop Logging: EEETE | ==
Logging Interval: 01:00:00 ﬁ
Sernsar \Warmup: 00:02:00 ﬁ
Circulator W ammup: IEID:EI2:EIEI ﬁ I Audic
Farameters in Sonde: Farameters in Log File:
Temp [C] -
oH [Uris] i |
ORP [m] {}
SpCond [mS/om) | o Temmtat
SpCond [uS /em] el s
Rez [kO-cm)
Sal [ppt]
TDS [9/]
5> feld 5> |
00 [mg]
BP [mmHg]
Depl 00 [meters] j Riemmye |
Create | Enable | [Nizakle | Delete | [avmlaad rarsren
| | |9:37:35 &M v
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2.2.4 Parameter Setup Tab

Click on the appropriate parameter and enter the setup information for each parameter.
Press SAVE SETTINGS when all parameter setup information is complete. Refer to the
instrument manual for more information for each parameter.

S_I,Istem] Online Munituring] Log Fileg Parameter Setup lEaIiI:uratiu:un] Settings] Suftware]

| Sallppt] DOMmas|  pH [Wnits] | Tubidiy MNTUS] |

Cond Temp Comp

| 1:Fresh ﬂ

Set Fange

| 1:40uto ﬂ

10:45:52 &M
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2.2.5 Calibration Tab

Click on the appropriate parameter and enter the calibration information for each
parameter. Press CALIBRATE when all the calibration information is complete. Refer to the
instrument manual for more calibration information.

i Hydrolab - COM 1

System] Orline Mu:unitu:uring] Log Files] Parameter Setup  Calibration l SEttings] Snftware]

DO[mgAl | BP[mmHgl | pH[Urits] | ORP[mv] | Dep200 [meters] | Turbidity [MNTUs] |
i SpCond [ms./cm] ] SpCond [uS/em] | Res[kO-cm] | Sallppt] | TDS[gA] | DO%[Sat] |

Current Y alue:

4.6 [m5/cm]

Temp: 23.70[C]
10/28/2003 10:46: 22 Abd
SpCaond [mS/zm]

| 56

Enter SpCond standard [mS /om]:

Calibrate

10:46:22 &M
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2.2.6 Settings Tab

aTT 1E —l—l_ g ﬂ
S_I.Jstem] Online Monitoring | Log Filesl ParameterSetup] Calibration  Settings ISDﬂware]

Communication

@ Baudrate @ MODEBLS

[1: 13200 =] Address: 1 3
=]l
[+ Enabled
Address: 1] =| Delay: 30 %] Seconds
[~ Enable Continuous Mode | Define S0 Parameter Order
Save Seftings |
Log Files
Files:

| J [ Auto Log ( : ) Statiztics

@ TTY Mode B attery Information

Enter Capacity [&h]:
Start Vaolkage (100%] W]

End Vaoltage [0%] []:

Type: |Intema| B attery ﬂ

Drate format

[MMD DY d

[v Usze Date/Time delimiter

: } Ophions Save Seftings |

5223 AM
# | Function Description
Select the instrument baud rate (1200, 2400, 4800, 9600, or 19200). Note: If the automatic baud
1 | Baud Rate rate scan is enabled (section 2.2.8.2 DataSonde Tab on page 25), Hydras 3 LT will only scan for

9600 and 19200 baud rates.

Enable SDI when multiple sondes or other SDI-12 enabled sensors are connected to a single
SDI-12 controller. Set the delay to allow the sensors to warm-up and stabilize for accurate

2 | SDI measurements. The transmitter factory default SDI-12 address is O for all parameters. If continuous
mode is enabled, the unit will never enter sleep mode and measurements will be available
immediately upon receiving an SDI-12 data request.

The Modbus address default is 1. When using multiple sondes, assign a unique address (1 to 247)

3 | MODBUS for each sonde. The Modbus works with even-parity, 8 data bit, and 1 stop bit.
When Auto Log is selected, it works as a back-up logging file. Auto Log captures a reading of all
4 | Log Files available parameters, battery voltages, and turns on the audio and circulator with a two-minute
9 warm-up (if installed) once every hour. ‘No log files’ must be selected in the Log Files tab for
Autolog to run.
5 | Statistics Press the STATISTICS button to view a summary of the sonde.
Use this option only when backwards compatibility is required. TTY mode provides data and limited
menu access for external devices that interface with earlier generations of sondes. If TTY mode is
6 | TTY Mode . - - .
entered, a user may exit TTY mode by opening a terminal screen and then pressing the space bar
followed by a Q or q to quit.
7 | Options See Hydras 3 Options (F2) on page 24.
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2.2.6.1 Define SDI Parameter Order

The user can define the order in which parameters are reported for an SDI-12 data
request. In the HydrolabsondeParameterOrderForm screen, the user can add parameters
to be reported using SDI-12 data requests. The user can also order the parameters by
using the UP and DOWN arrows to arrange the parameters in the desired order.

Note: The parameter order set in this screen will also be utilized by TTY mode for reporting data
values.

m Hydrolab5SondeParameterOrderForm - @ _ (O]

Parameters in Sande: Parameter Order:
Drate -

Time il

Temp ['C bz

pH [Urits] il Temp [C]

ORF [r] SpCond [mS/zm]
SpCond [mS/om] Sal [ppt]
SpCond [pS54cm) D% [Sat]

Fes [kO-cm] D0 [rmad]

54l [ppt] ¥ Add > ORP [mY]

TDS [/

D% [Sat]

D0 [mgA] LI Remove

k. Cancel
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2.2.7 Software Tab

Important Note: Level 3 Security Required. Software version 3.35 or higher is required to
use the features on the Software screen. If the sonde has an older version of software,
upgrade to the newest software version using terminal mode. Refer to the instrument
manual for more information on updating the sonde software using terminal mode.

aTT :E —I—I' = ﬂ
Sy&tem] Online Mu:unituring] Log Files] Parameter Setup Ealil:uratiu:un] Seftings  Sofbware l
W ET
@ Software version: |3.4|:| | Update |
Dirivers
Blot Driver Verzion

Remove ‘
) |

1 Cond 3.40 lptaliz

Z Oy 3.40 .

2 pH/ORE 2 40 [ Reset Driver After Update
4 DepthlOn Z.10

= Chlorophyll Z2.06&

& Turbidity Z.00

@ Reset Driver

@ Rezet Sonde

3:54:10 &M

# | Function Description

To update the firmware, click on the UPDATE button in the ‘Main’ group box. A prompt to select a file
1 | Software Version name will appear and then the selected file is uploaded to the sonde. After the upload, the sonde is
reset to default values and the sonde window is created again.

To remove a driver from a slot, select the driver and click the REMOVE button.

Drivers/Remove
After the driver is removed the sonde is reset and the sonde window is created again.
2 To update a driver, select the slot of the driver and click the UPDATE button in the ‘Drivers’ group
. box. Select a file name when prompted. The selected file is then uploaded to the selected slot in
Drivers/Update
the sonde.
If ‘Reset Driver After Update’ is checked, all driver parameters are set to default values.
3 | Reset Driver Resets all driver calibration parameters to default values.
Reset Sonde Resets all system parameters to default values.
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2.2.8 Hydras 3 LT Options (F2)

To set the sonde Options select File>Options or press F2 from the sonde startup screen.
The options menu contains two tabs, Graphics and DataSonde (sections 2.2.8.1
and 2.2.8.2).

2.2.8.1 Graphics Tab

The Graphics tab adjusts the settings and appearance of the graph (ruler size, labeling,
type of grid, and multiple graph functions).

Up to six selected parameters can be displayed, with different colors and an individual
axis range for every sensor. In the graphic options (F2), the user can select if every
parameter has its own vertical axis displayed or that only 2 vertical axis are used (one left,
one right).

HYDRAS 3 - Options
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2.2.8.2 DataSonde Tab

The user is able to define which serial ports to scan for sondes using the Options screen
(F2). Hydras 3 LT can be set to scan either all ports or only those ports indicated in the
ports list. A default PC baud rate can also be set. An extended timeout can be used when
the user is connecting to older Series 4a sondes, typically those built before 2002. If a
user is having difficulty connecting to a sonde, it is recommended that they set the
Communication screen to Auto Scan (all serial ports), check the automatic baud rate scan,
and use the extended timeout.

The DataSonde tab is used to select the PC baud rate (1200, 2400, 4800, 9600, or
19200), measurement units (Celsius, Fahrenheit, Kelvin, depth, and battery voltage), log
file formats (spreadsheet or printable), and format options such as date order, digits for
year, date separator, time separator, and radix (decimal point or comma).

HYDRAS 3 - DptiurE ed b

—Communication
—Paort Scan
{~ Scan for sondes at all COM ports

{* Scan at COM ports in list

|1

Port Mumbers must be separated by semi colonz.

Ilze - to specify a range of port numbers. Example: 1:3:8-12

—PC B audrate
|1 3200 j [T Usze automatic Baudrate Scan

¥ Use Extended Timeout [15 3 / Part)

—Preferred Unit
Temperature I “Celziug j
Crepth I meter j
B attery I"-.J'l:ult j
—Log File

Log File Farmat

I Spreadzhest

Le

—Format Option

Drate Order;

Diigits for Y'ear:

R adix;

Drate Separatar;

Time Separatar;

Il:l:nur'ﬂ:rj,I specific

|4

Il:l:nur'ﬂ:rj,I specific

Il:l:nur'ﬂ:rj,I specific

Il:l:nur'ﬂ:rj,I specific

Lf LefLef Lef e

]9 |

Cancel |
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Section3 Contact Information

U.S.A. Customers

By Telephone:

6:30 a.m. to 5:00 p.m. MST
Monday through Friday
(800) 949-3766 or
(970)669-3050

By Fax:
(970)461-3921

By Mail:

Hach Environmental

P.O. Box 389

Loveland, Colorado 80539-0389 U.S.A.

Ordering information by e-mail: sales@hydrolab.com

International Customers

To locate the representative nearest you, send an e-mail to: info@ott.com or
contact:

OTT Hydromet GmbH
Sales department
Ludwigstrasse 16

87437 Kempten

Germany

Phone: +49 831 5617-0
Fax: +49 831 5617-209
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Appendix A Troubleshooting

If Hydras 3 LT does not automatically detect the Sonde when launched, the following
screen will appear after a period of time:

=10l -10] x|

File Help
Connected Sondes:
Part | Saonde |
Fe-Scan for Sondes |
Operate Sonde |
Terminal Mode |
Log Files:
Part | Log File | Proagress |
Download Selected Files | [~ Delete files in sonde after reading

Save files to: C:4Program Files\HYDRASILT \LogFilesh Edit |

| | Y

Note: For some users with more than one active serial port, it will take some time for Hydras 3 LT
to try to auto-detect sondes on all ports. It may take up to 30 seconds per active serial port to do
the auto-scan.

If the sondes is not automatically detected, press the RE-SCAN FOR SONDES button. If
communication is still not established after several attempts, try the following:

Verify the Hardware.
1. Check power cables and connections:

a. Verify that your PC and multiprobe are properly connected to the wall outlet or
external battery if used.

2. Verify that the input voltage to the multiprobe is between 7V and 14V.

3. If your multiprobe is equipped with an internal battery pack, check the batteries'
polarity and voltages.

29



Troubleshooting

Verify the Hydras 3 LT Communication Settings.

1. Select File>Options from the Hydras 3 LT Connection Screen.

BTz =1
File Help

Port I énnde I
Re-Scan for Sondes |
Operate Sonde |
T erminal Mode |
Log Files:
Fort | Log File | Progress |
Download Selected Files | [ Delete files in sonde after reading
Save files tao: C:A%Program Filesh\HYDRASSLT “LogFiles'

| I y

2. Ifthe Sondes/PC baud rate and COM port are known, disable the COM Port and baud
rate auto scans and set Hydras 3 LT to use the known values. This requires
Hydras 3 LT to concentrate scan activities on only the serial ports of interest.
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3. In some cases, extending the connection timeout from 10 to 15 seconds, will improve
the connection procedure. This option allows time for additional retries. It is normally
disabled to decrease the time taken to scan for a sonde.

HYDRAS 3 - Dptiurﬁ d |

Graphic

 Communication

—Port Szan
= Sean for sondes at all COM parts
f* Scan at COM ports in list:

1

Fort Mumbers muzt be separated by semi colonz.
lze - to specify a range of port numbers. Example: 1:3:8-12

—PC Baudrate
|1 3200 j [~ Use automatic Baudrate Scan
[v Usze Extended Timeout [15 ¢ / Part]

—FPreferned Unit

Temperature I "Celziuz j

Drepth Imeter j

Battery I"»-"u:ult j
—Log File

Laog File Farmat ISpreadsheet j

—Faormat O ptian

Drate Order;

I Country specific

Digitz for Year:
[ate Separatar:
Time Separatar;

F adix;

|4

I Country specific:

I Country specific

I Country specific

LedLef Lefledle

OF. |

Cancel |
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